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[bookmark: _Toc61961191]Introduction and Background
[bookmark: _Toc297825328][bookmark: _Toc297892680][bookmark: _Toc298968222][bookmark: _Toc370744760]UPlan is the UCSF customized software of Oracle Enterprise Performance Management (EPM), a budgeting and forecasting application suite that includes Oracle Hyperion Planning.  Hyperion Planning sits on top of Oracle Essbase, a multidimensional database management system (MDBMS) that provides a multidimensional database platform upon which to build analytic applications.    
[bookmark: _Toc61961192]What is Essbase?
Essbase, whose name derives from “Extended Spread Sheet dataBASE”, began as a product of Arbor Software, which merged with Hyperion Software in 1998.  Hyperion Planning uses Essbase as a database and calculation engine, a relational repository for business logic, and a web-based user interface.  
[bookmark: _Toc61961193]What is Smart View?
Oracle Smart View for Office (Smart View) is a product in the Oracle EPM suite mentioned above that connects with Hyperion Planning and Essbase to allow users to view, import, manipulate, distribute and share data in Microsoft Excel, Word and PowerPoint.   
[bookmark: _Toc61961194]Why use Smart View?
UCSF uses Smart View for three main purposes:
1. An Excel interface for ad hoc analysis and reporting
2. An Excel interface for data input instead of the web-based forms
3. An Excel interface for viewing FR reports 
[bookmark: _Toc61961195]Smart View Add-in 
This document instructs how to download Smart View as an Excel add-in.  It then describes the Smart View Ad Hoc Reporting functionality, accessed using the Oracle Essbase option below.  Oracle Essbase is used for ad hoc queries and reporting in Excel.  Any reference to Smart View in this document should be taken in this context.  The three purposes of Smart View above are explained in relation to the three access options below.

[image: C:\Users\dbeaman\Desktop\2016-01-29_10-01-06.jpg]
[bookmark: _Toc61961196]Oracle Essbase
Oracle Essbase is the underlying database location where the raw data is stored.  This option goes directly to the multidimensional Essbase cubes (databases) for ad hoc analysis and reporting.  Users may create analyses/reports from a blank spreadsheet or refresh from pre-made templates.  
[bookmark: _Toc61961197]Oracle Hyperion Planning, Fusion Edition
The Hyperion Planning, Fusion Edition platform sits on top of the Essbase databases.  This option allows users to access the planning web forms via Excel.  Identical to the web, these forms are for data input or reports.  This option is fully covered in the Smart View Forms training manual, a separate document. 
[bookmark: _Toc61961198]Reporting and Analysis Framework
Reporting and Analysis Framework is the Excel interface for Hyperion Financial Reports (FR).  In the web interface FR reports are located via the Explore button: [image: C:\Users\dbeaman\Desktop\2016-01-08_13-00-43.jpg].  This option is not covered in any training documentation, although is very similar to the Hyperion Planning Fusion Edition functionality in nature.  

[bookmark: _Toc61961199]Getting Started
[bookmark: _Toc442444406][bookmark: _Toc61961200]Download and Install Smart View (download using any browser except Internet Explorer)
[bookmark: _Toc61961201]To get started
1. Confirm you have admin access to your machine.  If you do, skip to Step 2.  If you do not, you will be unable to download Smart View.  To request admin access, put in an ITS ServiceNow INC ticket and give the IT Field Services representative these instructions: 
2. Close all Microsoft products (Internet Explorer, Outlook, Word, Excel, Access, Visio, Project, PowerPoint, Lync, OneNote, Teams, InfoPath, Publisher, etc.)
3. Uninstall all older versions of Smart View from your system before installing the latest version.
[bookmark: _Toc61961202]To uninstall an older version of Smart View
1. Click Start 
2. Select Settings
3. Select System
4. Select Apps & features
5. Select the program you want to uninstall by clicking on it, and then click the Uninstall button
6. Restart your machine
[bookmark: _Toc61961203]To download and install Smart View
1. Download Smart View from any browser except Internet Explorer from the UPlan website at https://brm.ucsf.edu/uplan.
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2. Double-click on the “SmartView” application file.
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3. Click “Extract all” in the dialog box that appears.
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4. Click “Extract” in the dialog box that appears.
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5. Within the extracted folder, right-click on the “SmartView” application file and click “Run as administrator.”

[image: ]

6. Click “OK” in the dialog box that appears to proceed with installing Smart View.  Installing may take several minutes depending upon the speed of your computer or network connection.  During the process, you may see several black boxes flashing on the screen.  Do not touch the boxes or attempt to control the installation process.  When the download process is finished, you will see a small dialog box confirming the download is complete.
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7. Open Excel.
8. Go to the File tab > Options > Add-ins.
9. You should see the Oracle Hyperion Smart View add-ins (there should be two) in the Active Application Add-ins section.  If you don’t see the add-ins here, then go to the drop down menu at the bottom of the dialog box and select “Disabled Items.”  You should see the Oracle add-ins in the dialog box that appears now.

[image: ]
10. You should now see a new tab at the top of your Excel workbook titled “Smart View.”  Select the tab to launch Smart View.  If the Smart View tab ever disappears, see the Troubleshooting section to bring it back.
[image: C:\Users\nluong\AppData\Local\Temp\SNAGHTML10404dd7.PNG]


[bookmark: _Toc61961204][bookmark: _Toc370744763][bookmark: _Toc298514923]Launch Smart View 
[bookmark: _Toc61961205]To Log On to Smart View
1. Launch Microsoft Excel (MS Office 2007 and higher).
2. Select the Smart View tab.
[image: ]

3. In the Smart View Ribbon, select Options icon. This action opens the Options window.
4. Within the Options window, select Advanced in the left pane.  This action opens the Advanced tab of the Options window.

 [image: ]

5. In the General section, under Shared Connections URL, input the following URL: http://hyperwebprod04.ucsf.edu:19000/epmstatic/SmartView_Connections.xml
[image: ]

6. Click OK.  This action saves the Shared Connection edit.
7. In the Smart View ribbon, navigate to Panel.  This opens the Smart View Panel.
[image: ]

8. In the Smart View pane, click on Shared Connections. This action prompts the Shared Connections log-in pop-up window to appear.

[image: ]

· Shared Connections are available connections from a shared repository where business users can connect to group connections.  This connection is used the majority of the time to leverage Planning templates and Workspace content.
· Private Connections locally define connections and shortcuts.  
· The Home icon lets you navigate between Shared Connections and Private Connections.

9. Enter your UPlan User Name and Password.  Note that this is probably the same as your UCSF Active Directory (AD) ID and password.  Click Connect in the dialog box. This action activates the connection to UPlan via Smart View. 

[image: ]

10. Once the connection is active, click the “Select Server to proceed” drop down window and select the appropriate Hyperion tool:
· Oracle Essbase allows ad-hoc analysis [functionality explained in separate training document]
· Oracle Hyperion Planning, Fusion Edition allows data entry form templates 
· Reporting and Analysis Framework - formatted reports from Financial Reporting (FR) into Excel 
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11. Select the Oracle Essbase option. 
· Click on the + sign to Expand EssbaseCluster-1.  
· Expand the CmmtPln and USFPlan applications.  
· Expand the applications and double-click on the cubes/databases you wish to use.
 [image: ]

12. [bookmark: _Toc370744764]You will see several applications, which when expanded show the cubes/databases. 

[bookmark: _Toc61961206]Choose the source database
Choose the database you wish to pull your query or build your report from.  The following are explanations for each database you can run queries or reports from.  In the screen shot below the applications are listed first, with databases or cubes indented below them.
[image: ]
1. The applications/databases with current data are:
· CommtPln/CommtPln – current Commitments data.
· UCSFPlan/Empl – current Employee actuals and planning data at level C/E.
· UPlan/UCSFPlan –current UCSFPlan actuals and planning data at level C/E.
2. The applications/databases in yellow shading are archives with data reflecting the UCSF Chart of Accounts prior to 7/1/19:
· CmmtFY20/CmmtPlan – archived CmmtPlan data.
· PlanFY20/Empl – archived Empl data.
· CmmtFY19/CmmtPlan – archived CmmtPlan data.
· PlanFY19/Empl – archived Empl data.
· PlanFY19/UCSFPlan – archived UCSFPlan data.
· CmmtFY18/CmmtPlan – archived CmmtPlan data.
· PlanFY18/Empl – archived Empl data.
· PlanFY18/UCSFPlan – archived UCSFPlan data.
· CmmtFY17/CmmtPlan – archived CmmtPlan data.
· PlanFY17/Empl – archived Empl data.
· PlanFY17/UCSFPlan – archived UCSFPlan data.
· CmmtFY16/CmmtPlan – archived CmmtPlan data.
· PlanFY16/Empl – archived Empl data.
· PlanFY16/UCSFPlan – archived UCSFPlan data.
· CmmtFY15/CmmtPlan – archived CmmtPlan data.
· PlanFY15/Empl – archived Empl data.
· PlanFY15/UCSFPlan – archived UCSFPlan data.

[bookmark: _Toc61961207]Settings for Fastest Ad Hoc Queries
Setting Smart View options is a user preference.  The following settings are recommended for the best query return times.  Formatting and formulas will not be retained using the following settings.  
1. Click on the Options button.
2. Select the Member Options tab and set settings as seen in screenshot below:

[image: ]
· Zoom In Level – used for drilling on any dimension.  Typical user preference is “Next Level.”  This will drill down one level of the hierarchy at a time.
· Member Name Display – choose between displaying Member Name Only, Member Name and Description, or Description Only.
· Indentation – choose whether to indent totals, subtotals, or no indentation for visual purposes.  Note: indentation of Dimension lists indicates the Dimension’s hierarchy.
· Member Retention – Include Selection; this will keep totals when drilling on them.
· Use Double click for Operations – allows mouse functionality for drill-down.  
· Preserve Formula on POV Change – POV (Point of View) box changes will retain Excel formulas.  Leave unchecked for best query return times.
3. Select the Data Options tab and set settings as seen in screenshot below:
[image: ]
· Suppression Options (Rows/Columns) – Choose whether to display blank rows that have no data.  You cannot have these boxes checked if starting from a fresh worksheet.  
Note: Suppress Missing is available for Rows but not Columns.  In addition, the maximum row return is about 1 million rows.  The maximum column return is 256 columns.  See the Tips and Tricks section for a best practice recommendation for pivoting dimensions from Rows/Columns and Suppressing unnecessary dimensions.
· Replacement - This is the text result that appears when query result is zero/no data.
· #NoData/Missing – for blank cells to appear blank, delete “#Missing”.
· Mode – screenshot options above are the default.
· “Navigate Without Data” option should only be checked in situations when validating metadata and data analysis is not necessary. 
4. Select the Advanced tab and set settings as shown in the screenshot below:
[image: ]
· Shared Connections URL – should have been completed in previous section – “Smart View Setup”.  Ensure it is set to: http://hyperwebprod04.ucsf.edu:19000/epmstatic/SmartView_Connections.xml
· Number of Undo Actions – default is 9; similar to MS Office “Undo” feature; handy option if you drill down too far or refresh query and do not want to keep results.
· Logging – this is generally never used.  Creates log files and records errors, events and other information.  This can help Customer Support IT troubleshoot issues.
· Disable Smart View in Outlook – Smart View can cause conflicts in Excel if Outlook has Smart View enabled simultaneously.  It is recommended to check this box.
5. Select the Formatting tab and set settings as shown in the screen shot below:

[image: ]
· Use Thousands Separator – Will allow thousands separator in the Planning Forms but not in ad hoc reporting.  
· Cell Styles – Use Smart View default cell styles.  Check for best query return times.  
· Use Excel Formatting – User defines the formatting retained when refreshing such as commas, decimals and coloring.  
· Retain Numeric Formatting – Will retain formatting on the page such as commas, decimals and coloring.  Leave unchecked for best query return times.  
· Adjust Column Width - Enable Smart View to adjust grid column widths automatically to fit cell contents.  Leave unchecked for best query return times.
· Decimal Places – by default, will generally show complete value in cell (including fractions)
· Repeat Member Labels – This option is only relevant for the Planning Forms.  It is recommended to leave unchecked for navigating the forms and checked if you want to copy/paste results into a pivot table for ad hoc analysis.
· Cell Styles and Extension tabs – default options do not need to be change.

[bookmark: _Toc61961208]Settings for Retaining Formatting and Formulas
Setting Smart View options is a user preference.  The following settings are recommended for retaining numeric formatting, formulas, or refreshing report templates.  Formatting and formulas will be retained using the following settings.  
1. From the Options window, select the Member Options tab and set settings as seen in screenshot below:

[image: ]
· Zoom In Level – used for drilling on any dimension.  Typical user preference is “Next Level.”  This will drill down one level of the hierarchy at a time.
· Member Name Display – choose between displaying Member Name Only, Member Name and Description, or Description Only.
· Indentation – choose whether to indent totals, subtotals, or no indentation for visual purposes.  Note: indentation of Dimension lists indicates the Dimension’s hierarchy.
· Member Retention – Include Selection; this will keep totals when drilling on them.
· Use Double click for Operations – allows mouse functionality for drill-down.  
· Preserve Formula on POV Change – POV (Point of View) box changes will retain Excel formulas.  Check to preserve formulas when refreshing queries or report templates.
3. Select the Data Options tab and set settings as seen in screenshot below:
[image: ] 
· Suppression Options (Rows/Columns) – Choose whether to display blank rows that have no data.    You cannot have these boxes checked if starting from a fresh worksheet.  Note: column suppression is currently not allowed.
· Replacement - This is the text result that appears when query result is zero/no data.
· #NoData/Missing – for blank cells to appear blank, delete “#Missing”
· Mode – screenshot options above are the default.
· “Navigate Without Data” option should only be checked in situations when validating metadata and data analysis is not necessary. 
4. Select the Advanced tab and set settings as shown in the screenshot below:
[image: ]
· Shared Connections URL – should have been completed in previous section – “Smart View Setup”.  Ensure it is set to: http://hyperwebprod04.ucsf.edu:19000/epmstatic/SmartView_Connections.xml
· Number of Undo Actions – default is 9; similar to MS Office “Undo” feature; handy option if you drill down too far or refresh query and do not want to keep results.
· Logging – this is generally never used.  Creates log files and records errors, events and other information.  This can help Customer Support IT troubleshoot issues.
· Disable Smart View in Outlook – Smart View can cause conflicts in Excel if Outlook has Smart View enabled simultaneously.  It is recommended to check this box.
5. Select the Formatting tab and set settings as shown in the screen shot below:
[image: ]
· Use Thousands Separator – Will allow thousands separator in the Planning Forms but not in Ad hoc reporting.  
· Cell Styles – Use Smart View default cell styles.  Check for best query return times.
· Use Excel Formatting – User defines the formatting retained when refreshing such as commas, decimals and coloring.  Check to retain Excel formatting when refreshing in queries or report templates.  
· Retain Numeric Formatting – Will retain formatting on the page such as commas, decimals and coloring.  Grayed out if Excel Formatting is checked.  
· Adjust Column Width - Enable Smart View to adjust grid column widths automatically to fit cell contents.  Leave unchecked for best query return times.
· Decimal Places – by default, will generally show complete value in cell (including fractions.
· Repeat Member Labels – This option is only relevant for the Planning Forms.  It is recommended to leave unchecked for navigating the forms and checked if you want to copy/paste results into a pivot table for ad hoc analysis.  
· Cell Styles and Extension tabs – default options do not need to be change.

[bookmark: _Toc61961209]UPlan Dimensions in Smart View
Dimensions are metadata within a dimensional database and the primary way that data is categorized in UPlan.  Members are the individual representations for the dimensions.  For example, Period is a dimension that has “Jul” and “Aug” as members.  You will notice differences between the Dimensions that you can view in the UPlan web interface versus UPlan in Smart View.  Some of these key differences are described below.
[bookmark: _Toc61961210]Period
The Period dimension contains “YearTotal” and months.  There is an additional member called Admin_Period that is hidden in web forms.  This member should not be used for retrievals as it has no data associated with it.
[bookmark: _Toc61961211]Years
The Years dimension contains members for years not currently included on the General Planning and Employee Planning forms (i.e. 2012-13, 2021-22).  In General Planning and Employee Planning, there is no data associated with the outlying years so they should not be used.
[bookmark: _Toc61961212]Scenario
This Scenario dimension is the same in the planning forms as it is in ad hoc reporting.
[bookmark: _Toc61961213]Version
The Version dimension contains a “What If” member that is hidden in the web forms.  This member should not be used for retrievals as it currently contains no data.
[bookmark: _Toc61961214]Fund
The Fund dimension contains an additional group of members under a hierarchy called “Global Assumptions Funds.”  These members assist with the Global Assumption process and have no data associated with them so they should not be used.
[bookmark: _Toc61961215]DeptID
The DeptID dimension contains an additional group of members under a hierarchy called “Input DeptID.”  These members assist with the Global Assumption process and have no data associated with them so they should not be used.
[bookmark: _Toc61961216]Title Code
The Job Code dimension contains title codes assigned to individual employees.  An employee can have multiple job codes.  Job Codes are organized in several hierarchies, including by Union Code.  To look up a Job Code and its Union Code, refer to the Job Code lookup in MyReports (Inquiry Reports Tab), the Controller’s Office website (Inquiry Reports Tab), or the HR website.  Smart View users should use the “All Title_Codes” or “Employee Type” hierarchies for data retrievals.  The Input hierarchy is only used to facilitate Global Assumptions processes and contains no data.

[bookmark: _Toc61961217]Employee
The definition of this dimension is the same in Smart View as in UPlan web and employee names are listed alphabetically based on last name and are grouped by alphabet (e.g., A-C, D-H, I-L, M-Q, R-T, and U-Z).

[bookmark: _Toc61961218]Project
The Project dimension is set up exactly as it is in web forms.  The hierarchy includes the Project Use as well as individual Project IDs.
[bookmark: _Toc61961219]Account
The Account dimension is essentially the same as what you will see in the planning forms except accounts are included within this dimension in three separate hierarchies: one for Employee accounts, one for General accounts, and the other for Old Employee accounts for reference only.

[bookmark: _Toc61961220]Ad Hoc Analysis with Smart View and Essbase 
[bookmark: _Toc61961221]Accessing Essbase via Smart View
1. Ad hoc analysis is available using Essbase.  Go to Shared Connections and select the Oracle Essbase server in the drop down menu.
[image: ]
2. All of the databases within UPlan will appear.  The most commonly used databases for ad hoc analysis are UPlan and CommtPln.
  [image: ]
3. Use UPlan for aggregated General Planning analysis. 
4. For purposes of illustration, double-click on the UCSFPlan database.
5. The default grid page looks like this:  
[image: C:\Users\dbeaman\Desktop\2016-02-05_14-34-07.jpg]
[bookmark: _Toc61961222]Navigating the Smart View Ribbon
[bookmark: _Toc61961223]Undo
Undo the previous ad hoc operation.  You must Refresh to see the result of the Undo.
[image: ]
[bookmark: _Toc61961224]Refresh
Refresh the data on the current worksheet from the data source. Note:
· You can also double-click in any blank cell in the worksheet to Refresh the worksheet.
· Refresh is the only button that appears in both the Smart View and Essbase ribbons.

[bookmark: _Toc61961225]Options
Set a variety of options for working in Smart View.  The options are explained in full detail in the Getting Started section.
[bookmark: _Toc61961226]Panel
Used to launch your Smart View connection to UPlan database servers.
[bookmark: _Toc61961227]Submit Data
Used to upload data from Smart View to the Hyperion Planning application system.  This functionality is not permitted in Smart View ad hoc reporting at this time.

[bookmark: _Toc61961228]Navigating the Essbase Ribbon
When you connect for the first time, an Essbase ribbon will appear at the top of the page.  The following are explanations of the key functions in this ribbon.
[bookmark: _Toc61961229]Zoom In
If you click the arrow, you have several options including: Next Level, All Levels and Bottom Level.  Clicking Zoom In will default to your zoom setting in your Options.  The default is to Zoom in on the Next Level down in the dimension hierarchy.
[image: ]
[bookmark: _Toc61961230]Zoom Out
Highlight the cell and click Zoom Out.  Zoom Out goes up to the next level of the Dimension.
[bookmark: _Toc61961231]Pivot
Pivot a Dimension’s placement between the row and column on the worksheet.  See the Moving Dimensions section for more pivot options. 
[bookmark: _Toc61961232]Keep Only
Select the cells to keep, and click the Keep Only button.  All other members of that Dimension will be removed.  For example, Keep Only on ‘Jul’ will remove all other months in the Period Dimension already displayed on the worksheet.
[bookmark: _Toc61961233]Remove Only
Highlight cells you want to remove, and hit the Remove Only button.  All other members of that Dimension will remain.  For example, Remove Only on ‘Jul’ will remove only July and leave all other months already displayed on the worksheet.  
[bookmark: _Toc61961234]Member Selection
Highlight a Dimension member cell and select Member Selection.  Expand/Drill In to the Dimension list to select one or multiple members.  You can also type the name or alias of the dimension into the search bar including using a wild card * to find the dimension in the hierarchy.

· To simultaneously select multiple members of a Dimension if they are at the same level of the Dimension’s hierarchy tree:
1. Open the Member Selection box for the dimension (e.g., the Account for dimension).
2. Select an account in the hierarchy (e.g., select ‘UCSF Accounts’).
[image: ]
3. In the middle of the box are the ‘Add’ and ‘Remove’ arrows which also have arrows next to them for a drop down menu.
4. Select ‘Level’ from the drop-down menu and a new box appears.
5. Select the correct Level (e.g., Level 1).
[image: ]

6. Everything that falls under Level 1 in the selected Dimension’s hierarchy will appear in the right-hand side box.  
[image: ]
7. NOTE: This doesn’t guarantee that you’ve selected every member you desire, so you’ll probably want to pull in a parent member from the hierarchy to check your totals (e.g., pull in Total Revenue or Total Expense and compare that value to the sum of the accounts you pulled from step 8).
[bookmark: _Toc61961235]Refresh
Refresh the data on the current worksheet from the data source.  Note:
1. You can also double-click in any blank cell in the worksheet to Refresh the worksheet.
2. Refresh is the only button that appears in both the Smart View and Essbase ribbons.
3. The best practice when manually moving dimensions by dragging/dropping or cut/pasting on the worksheet is to Refresh the worksheet after each dimension is moved.  

[bookmark: _Toc61961236]Change Alias
By default Smart View populates dimension Aliases when starting from a blank worksheet.  Aliases, while helpful because they are longer and more descriptive, also take up more space on your screen.  If you wish you change the aliases to show the dimension names instead, click Change Alias > Select None.  The dimensions all change from their aliases to their names.  Navigating and knowing the Essbase Names instead of Aliases takes practice.  Click Change Alias > Select Default to change the names back to aliases.

[bookmark: _Toc61961237]Point of View (POV)
The POV is the location of the static dimensions that you wish to persist throughout the entire worksheet.  The Columns and Rows are the location for the non-static dimensions that can change.  
To illustrate, in the UCSFPlan cube Revenue & Expense form the dimensions in the POV are the DeptID, Fund, and Project.  When you select these three dimensions, they are the 3 static members that you see reflected on that form.  All other dimensions are non-static and are located in the Columns and Rows.  In the Revenue & Expense Form example, Scenario could be either Plan or Actual; Account could be Staff Salaries or ICR Revenue; Period could be either Jul or YearTotal, etc.  
In Smart View the POV location is by default, in the top row.  However, the POV can be viewed three different ways in Smart View.  The examples and screen shots below refer to dimensions in the UCSFRptg cube.  
[bookmark: _Toc61961238]POV Option 1 (Default): POV Dimensions in the top row
When dimensions come in on a blank/new worksheet in Excel they appear with most dimensions in the top row, the Account Dimension in the Column, and the Period Dimension in the Row (see below).  Though nothing in Excel explicitly states that POV = top row, in Smart View the POV is the first row where Dimensions appear.  This means it is possible to insert blank rows above Row 1.  If you do this the POV Dimensions must all be on the same line.  If they are not on the same line, Essbase will read the highest row with any Dimension as the POV, and all dimensions below that row as either a Row or Column.  
[image: ]
[bookmark: _Toc61961239]POV Option 2: POV Dimensions floating in the worksheet
When you click the POV button in the Essbase ribbon, it removes the Dimensions from Row 1 and puts them into a floating POV window.  Notice you can now toggle/change your POV Dimensions as drop down menu items.
[image: ]
[bookmark: _Toc61961240]POV Option 3: POV Dimensions fixed above the top row
From Option 2, when you click and drag the floating POV box above the top row, Excel dynamically creates space for you to drop the box into its own window (see below).  The drop down menu item functionality is the same as Option 2.  You can drag/drop the POV from Option 3 back to Option 2 by clicking and dragging the box from the top of the gray POV bar (see below).
[image: ]

[bookmark: _Toc61961241]Moving Dimensions with Pivot
There are several ways to move the UPlan Dimensions on your spreadsheet in order to set up your ad hoc analysis and drill through the Dimension hierarchies.  It is important to understand each of the UPlan Dimensions and structure of each Dimension’s member hierarchy in order to successfully set up and drill up/down on your Dimensions.  
[bookmark: _Toc61961242]Pivot Option 1: Using the Pivot Button 
Use the Pivot icon on the Essbase menu ribbon to move your dimensions on the spreadsheet grid.  A few things to know about pivoting:
1. Select a dimension before clicking pivot to move it from POV to Row/Column and vice versa.
2. Select a dimension that is currently in the POV or Column > click pivot.  It will automatically pivot it to Excel Column A (the left-most dimension in the rows).
3. Notice if a Row or Column only has one dimension in it, and you click pivot, Smart View will pivot the dimension wherever you are sending it.  However it will also dynamically replace that dimension you pivoted with a different dimension in its place.  In this way, there is always at least one dimension in the Row and one dimension in the column.
[bookmark: _Toc61961243]Pivot Option 2: Left-click to drag and drop
When you select a dimension, Smart View will put a black bold border around it (see screen shot below).  Moving your cursor to the border changes the cursor into a crosshairs, allowing you to “grab” the dimension.  Click and drag that dimension from a row to a column, etc.   
Best Practice:  Refresh the worksheet every time you move a dimension anywhere on the screen.
[bookmark: _Toc61961244]Pivot Option 3: Right click to drag and drop
Holding down the right click on your mouse and dragging a dimension to its desired location will also move it.  There are several benefits to this method:
1. Smart View will dynamically move the other dimensions on the page to accommodate the new dimension locations.
2. During the drag/drop the Dimension name appears in a tan box next to your cursor so you know what you are moving/pivoting.
3. Since the dimensions are dynamically moved you will not need to refresh the worksheet after dropping it.
[bookmark: _Toc61961245]Populating Dimensions 
[bookmark: _Toc61961246]Typing Members directly into the cell
The fastest way to populate a dimension is to type it directly into the cell.  You can type the member name or alias (see the UPlan Dimensions section in Smart View section for dimension explanations).  Several things to know about this functionality:
1. It does not matter if you type the Essbase Dimension Name or Alias (i.e. the Essbase Name is ‘5000 and Essbase Alias is “5000: Campus core fund”.  
2. Occasionally Essbase will recognize typos but in general either the Name or Alias must be entered without typos to be recognized.
3. It does not matter if you type a dimension in lower/upper case or some combination thereof (i.e. “total funds” will render the same result as “Total Funds”).
4. When you type in your dimensions, you must refresh the worksheet to render the new/modified dimensions.
5. You can type over existing members with a different member of the same dimension and refresh without issue.
6. You can type over existing members with a different member of a different dimension, but you may have an issue if the member is now in both the row and column (not allowed).
[bookmark: _Toc61961247]Using Member Selection 
To select one or multiple members, do the following:
[image: ]
1. Click on the member you wish to change then click on Member Selection.
2. Find the member in the search bar or dimension hierarchy.
3. Select the member in the left.
4. Click the right arrow to move it to the selection box.
5. Optional: Remove any superfluous members back to the left.
[image: ]
6. Click Refresh or double-click on any blank cell to refresh the worksheet.

[bookmark: _Toc61961248]Zoom In & Zoom Out
To drill in to the next level below in the dimension hierarchy you can use the Zoom In button.  To drill out you can use the Zoom Out button.  Shortcuts for these buttons are: Double left-click for Zoom In and Double right-click for Zoom Out.  Due to a ragged UCSF Chart of Accounts hierarchy, the most common Zoom In options planners will typically use are: Next Level, Bottom Level and occasionally All Levels or Same Level, followed by Suppress Missing and Keep/Remove Only to show only the relevant dimensions.
Below is an example of how to use several common Zoom In/Out options to populate the Employee dimension.
1. Double-click on the Empl cube (database) in the Smart View Panel on the right.
2. Select the Employee cell and click the Zoom In drop down menu and select Next Level. 
3. Zoom In on Total Employees.  Zoom In on Existing Employees.
4. Select Existing Employees and Zoom In Bottom Level.  All Employees with last names A-C populate the spreadsheet.
5. Scroll down the spreadsheet to highlight the parent Account dimension Existing Employees A-C, and select Zoom Out.
6. Click on the Options icon in the Smart View ribbon menu.  In the Data Options menu check the boxes to Suppress No Data/ Missing Rows.  Click OK.
[image: ]
7. Refresh.
8. Select Existing Employees, Zoom In Next Level.  Select Existing Employees A-C, Zoom In Bottom Level. 
9. Now, your spreadsheet will populate with only the employees with data at the DFP and POV you’ve chosen.
10. Use Excel formatting functions to format your number data as desired.

[bookmark: _Toc61961249]Advanced Tips and Tricks
[bookmark: _Toc61961250]Type Dimension Names not Aliases
In Navigating the Essbase Ribbon you read the description of the Change Alias button.  You also read the fastest way to populate a dimension into a cell is to type it directly into a cell.  Therefore, the fastest way to enter a dimension into a cell is to type its Name instead of its Alias.  This trick usually takes practice and probably requires you to Click the Change Alias button and select ‘None’ so that you can familiarize yourself with Dimension Names instead of Aliases.  Below are the Dimension Names with common examples that will definitely speed up ad hoc analysis queries.
Note: due to Excel functionality, a cell with all numbers will be read as a number instead of text.  Therefore Essbase will read it as data in the wrong location instead of metadata in the correct location, and you will receive an error.  In the examples below, Account 43150, Fund 5000 and ProjectID 1111111 require an ‘ apostrophe so that they will be read as text (metadata), whereas Fund 100A, Title Code T0001 and DeptID D999999 include a letter therefore do not need to be preceded by an ‘ apostrophe.
[bookmark: _Toc61961251]Account
4000A/B/C/E
‘43501
OpRevTrans
TotRev 
5000A
OpExpTrans
TotExp 
IncLossOps
5700A
TotOthChg
ChgPos
BegBal
EndBal

[bookmark: _Toc61961252]DeptID
D999999

[bookmark: _Toc61961253]Fund
‘5000
100A

[bookmark: _Toc61961254]Project
‘1111111
[bookmark: _Toc61961255]TitleCode
J000001

[bookmark: _Toc61961256]Year
FY20

[bookmark: _Toc61961257]Scenario
No change.

[bookmark: _Toc61961258]Version
No change.

[bookmark: _Toc61961259]Period
No change.

[bookmark: _Toc61961260]Dimension Placement
The following screen shots show rules for basic dimension placement in Smart View.
	1. A grid must have at least one row dimension and one column dimension.

	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-47-21.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-48-27.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-48-51.jpg]

	Not OK- Missing a Row Dimension
	Not OK- Missing a Column Dimension
	OK



	2. Each row dimension can contain members of only one dimension. Each column dimension can contain members of only one dimension.

	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-49-30.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-49-59.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-50-57.jpg]

	Not OK- More than one dimension in the same row/column combination
	Not OK- More than one member of the same dimension in two different columns
	OK



	3. Members of one dimension can be entered only in one of the following regions:
a. In the same row
b. In the same column

	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-57-45.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_14-59-05.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_15-00-52.jpg]

	Not OK- Members of the Account dimension (Total Revenue and Total Expenses) located in different columns
	Not OK- Members of the Period dimension (Period and YearTotal) located in different rows of the same column
	OK



	4. The page dimension region can contain members of different dimensions, but no two members in the page dimension region can belong to the same dimension.

	[image: C:\Users\dbeaman\Desktop\2016-02-05_15-02-45.jpg]
	[image: C:\Users\dbeaman\Desktop\2016-02-05_15-04-00.jpg]

	Not OK- Members of the DeptID dimension located in  2 different columns
	OK



	5. Grids do not need to start in cell A1.

	[image: C:\Users\dbeaman\Desktop\2016-02-05_15-04-32.jpg] OK



	6. When creating an ad-hoc default grid, if NoData/Missing is checked under Smart View > Options > Data Options > Suppress Rows, the error “Resulting grid does not contain at least one row, one column, and one POV” will appear.  To correct, the Suppress Rows Option needs to be unchecked.

	     [image: ]                 [image: ]                                   

	

	


7. When connecting to a cube via Smart View on a worksheet that is different from the previous connection, the below pop-up window will appear.  You’ll need to choose one of the following:
a. Clear sheet contents and POV- to wipe out the previous grid set up.
b. Reuse sheet contents only- use the new connection POV instead of the old; the data will be refreshed according to the new POV/row/column dimensions.
c. Reuse sheet contents and POV- use the old POV instead of the new; the data will be refreshed according to the old POV/row/column dimensions.
[image: ]

[bookmark: _Toc61961261]Pivot from Smallest to Largest Dimension
As you read in the Smart View Options, you are able to Suppress Rows but not Columns.  In addition, the maximum row return is about 1 million; columns are 256, and you cannot suppress columns when you Zoom In/Out.  Therefore the fastest way to Zoom In on the necessary dimensions are to pivot, Zoom and Keep/Remove in a specific order.  Let’s say you wanted to see only TotRev, TotExp, and TotOthChg for every DeptID, Fund and Project combination in a particular department YTD (YearTotal).  You could start by arranging your query like this:

 [image: ]



Then, one at a time, you could pivot the smallest dimension to the Row, Zoom In Next/Bottom Level, Keep/Remove Only on what you need and/or Suppress Missing and repeat.  In this example DeptID is usually smaller in number than Funds used for each DeptID, and Fund is smaller than number of ProjectIDs for each D-F combination.  So pivoting in the order of DeptID first, Fund second and Project last is usually best in order to minimize the number of rows on the worksheet.  Some screen shots to illustrate:
1. Pivot DeptID into Row.  As you read in the Pivot Section it automatically goes to Column A.
 [image: ]
2. Zoom In and/or Keep/Remove Only and/or Suppress Missing on what you need.  These can be done in any order.
  [image: ]
3. Pivot Fund into Row.
 [image: ]
4. Right-click drag and drop to move DeptID to the left of Fund.
 [image: ]
5. Zoom In and/or Keep/Remove Only and/or Suppress Missing on the Funds you need.  These can be done in any order.  Pro Tip: Go to Smart View Ribbon  > Member Options > Uncheck Include Selection Box in Member Retention section to drill to Bottom level without seeing any parent dimensions like “Total Funds”, etc.
 [image: ]
6. Pivot Project into Row.  Pro Tip: right-click drag and drop Project in between Fund and Account.
 [image: ]
7. Right-click drag and drop to move DeptID and Fund to the left of Project if it is not already there.
8. Zoom In and/or Keep/Remove Only and/or Suppress Missing on what you need.  These can be done in any order.
 [image: ]

In certain instances, Zoom In Bottom Level, especially on “Total Projects” with Suppress Missing Checked can render a maximum row error:
[image: C:\Users\dbeaman\Documents\Snagit\11-17-2015 12-31-17 PM.png]
To finish getting to the bottom of the hierarchy, the next tip is to Zoom In Next Level for each child down the hierarchy.  In this example with Total Projects, Zoom In Next Level from “Total Projects” renders less rows than if you were to use Zoom In Bottom Level and makes the query possible. 

[bookmark: _Toc61961262]Max Row Error
If you receive the max row error on Zoom In Bottom Level for a high member like “Total Projects”, try something that renders less rows like Zoom In Next Level.  Continuing with the example in the previous Tip section,
1. Select Total Projects, Zoom In Next Level.
2. Notice Total Project is now the next child (or children) down in the project hierarchy, Project Use (i.e. General, Programmatic Investment, Sponsored, etc.).  Zoom In Next Level again.
 [image: ]
3. Notice General is now the next level down.  Zoom In on General first.
 [image: ]
4. Then Zoom In on Prog_Investmt > Keep Only on the Project IDs or Remove Only on the Project Uses.
[image: ]

[bookmark: _Toc61961263]Cascade
Occasionally you will want to Zoom In and populate the results of each dimension on different worksheets either within the same workbook, in another workbook, or multiple workbooks.  The Cascade feature allows you to pull the data and quickly arrange it in this manner.  For example, if you wanted to show the YTD actuals for all FAS departments with each Level E accounts in the Rows and each Department in a separate workbook, you would do the following:

1. Enter the relevant dimensions from scratch with repeated dimensions in the POV.  
 [image: ]
2. High-level Accounts are in the Rows.
3. Drill In Bottom Level on the high level accounts.
[image: ]
4. Suppress Missing on Rows.  Highlight all of the level F accounts under Total Revenue and select the Zoom Out button.  Repeat for level F accounts under Total Expense and Total Other Changes.
[image: ]
 [image: ]
5. The Dimension you are cascading must be in the POV.  If it is in the Row or Column, you will not be able to cascade it.  In this example, since you are cascading DeptID, verify that it is in the POV.  Click on Cascade.  You will see 3 options for Cascade:
a. Same Workbook.  This option will open a separate worksheet for each dimension chosen to cascade in the current workbook.
b. New Workbook.  This option will open a new workbook with each dimension chosen to cascade on each worksheet in the new workbook.
c. Different Workbooks.  This option will open a new workbook for each dimension chosen to cascade on one worksheet in each new workbook.
[image: ]
6. Choose the first one for each DeptID tab to appear in the current worksheet.  
[image: ]
7. The Select Cascade Members Selection dialog appears with the default dimensions.  
[image: ]
8. Click on each Member Selection icon to change the dimension you want to cascade.  In this case, click on DeptID.
[image: ]
9. Select the DeptIDs you wish to cascade.  

Best Practice: enter D400000 in the search bar and click Enter.  Select D400000 and in the drop down menu in the middle select Children.  Move any dimensions already in the right side of the box back to the left.  Click ok.
 [image: ]
[image: ]
[image: ]

10. The DeptIDs chosen appear as separate worksheets in the same workbook.
 [image: ]
[bookmark: _Toc61961264][bookmark: Troubleshooting]Troubleshooting
[bookmark: _Toc61961265]What do I do if Smart View becomes disabled in my Excel app?
1. Open Excel and go to File > Options > Add-Ins.

2. On the Manage drop down list at the bottom of the Options window, select “Disabled Items” and click Go. 

[image: ]
        
3. After you click on Go the following window will appear.	 
[image: ]

4. In the case where Smart View was disabled, you will see Smart View in the disabled items box.
5. Select Smart View and click on Enable.
6. Close Excel and reopen it, and Smart View should show up again.
[bookmark: _Toc61961266]UPlan User Support Info
For user support, send an email to: uplan@ucsf.edu.


4	02/04/2021

02/04/2021	3

image1.png




image2.jpeg




image3.png
University of California
San Francisco




image4.jpeg
Orade® Essbase x| ¥
Orode® Exsbase ]

Orade Hyperion Planning, Fusion Editon [

O ol N R Y




image5.jpeg
- Exlore




image6.png
l@ Budget and
Resource Management

Home + Department Units v CBR +

Home > UPlan > Getting Started > Download Smart View

Download Smart View

Recharge Review v STIP UPlan

Search Q

FAS DSCP

Smart View is an excel interface that connects with Hyperion Planning and Essbase to allow users to perform ad hoc analysis and reporting, input

data instead of the web-based forms, and view Financial Reporting (FR) reports.

Windows Users

Smart View for Windows

Home Inset  Pagelayout  Fomulas  Data  Review  View

9 Undo B Copy E]
e Comectons e e i St Ot

Developer

start et oata General

AL - £

‘Smart View Tab

Download Smart View

Version: 20.100 (Build 230)
Oracle Build Date: June 1, 2020

Shared Connections URL for Smart View Advanced Options:




image7.png
[8 <« Temp > svc 20100

vo

Search svc_20100

Name

D smortview_20100_readme
(5] SmartView

Type

Firefox HTML Document
Application
XML Document

Compressed size Password ...

13KE No
144546 KB No
KB No

Size

sake
149,172KB.
KB

Ratio

76%
%
5%

Date modified

6/12/2020 545 PM
6/1/2020 1034 AM
6/1/2020 1034 AM




image8.png
Compressed (ipped) Folders x

This application may depend on other compressed
fies inthis older.

Forthe appication o run propery. i recommended
that youfrst extract al fies.

= e e





image9.png
11 Extrct Compressed Zipped) Foders

Select a Destination and Extract Files.

Files will be extracted to this folder:

[CRUservtuongNDocumentzeve 5100

how extracted files when complete.





image10.png
[1> ThisPC > Documents > svc_20100 v O | Search svc 20100

Name Dste modifed Tpe Size
) smart_view 20100, readme 0/17/2020904PM  Firefox HTML Doc. sike
(] Smartview Apy 149,728

! version Open XML Document Ke

© Run a5 saministotor

Troubleshoot compatibilty
Pinto Start





image11.png
Oracle Smart View for Office Installation

Select destination folder for Oracle Smart View

[coracle\smartview





image12.png
Excel Options
General
24 View and manage Microsolft Offce Addins.
Formulas
Proofing Add-ins
save Norme — Tiocstion Trpe =]
Language [Active Applcation Add-ins
|oracle Smart View for Office CA\Oracle\SmartView\bin\HsTbarada  Excel Add-in
Advanced racle Smart View for Office CA\Oracle\SmartView\bin\HsAddindll  COM Add-in
Customize Ribben Inactive Application Add-ins
Quick Access Toolbar | Acrobat PDPMaker Office COM Addin CA\.enOfficews\PDFMOfficeAddin.dil
(Analyss ToolPak CA\.16\Library\Analysis\ANALYS3ZXLL  Excel Add-in
|Analysis ToolPak - VBA CA\.6\Librery\Analysis\ATPVBAEN XLAM  Excel Add-in
Fa— Date (ML) CA\..rosoft shared\Smart Tag\MOFLDLL ~ Action
Euro Currency Tools CA\.\Officel6\Librany\ EUROTOOLXLAM  Excel Add-in
Hyperion® (Hyperion Smart View recognizer) - C:AWindows\System32\mscoree.d Action
Inquire CA\.Office\Office16\DCRNativeShim.dil  COM Add-in
Microsoft Actions Pane 3 XML Expansion Pack
Microsoft Power Map for Excel CA\..cel Add-in\ EXCELPLUGINSHELLDLL  COM Add-in
Microsoft Power Pivot for Excel CA\..d-in\PowerPivotExcelClientAddin.dil I
Microsoft Power View for Excel CA\.din\AdHocReportingxcelClient.dil
Solver Add-in CA\.ceT6\Libran\SOLVER\SOLVER XLAM
Addin: Oracle Smart View for Office
Publisher:
Compatibilty: No compatibilty information available
Location:  C:\Orecle\SmartView\bin\HsTharala
Description:
Manage: [ Excel Add-ins )
Excel Add-ins
CoM Add- oK Cancel
T T T Actions T T T T T T
XML Expansion Packs





image13.png
PageLayout Fornulss  Data View  Developer Q Tell me what you want o do

N i Copy @ B E

- G @ Paste. &* Sheet Info
Panel  Connections Refesh  Submit Options — '

“ e e e
— & e o





image14.png
Home Inset  Pagelsyout Formulss  Data View  Developer Q Tell me what you want o do.

1 Undo B Copy ' Help -
@ Jlan ©8

& Sheet Info.
Panel  Connections. Refresh ~ Submit | Options|
Functions~  ~  Data ] More~

Start Edit Data General




image15.png
Member Options.

Data Optons.

Formating

celstyles

Extensons





image16.png
Options

Member Options.
Data Optons:
Advanced
Formating

celstyles

[y cranse bt sart v epons

General
Shered Connectons LRL: hitp: Jhyperwebprodd4: 19000/epmstati/Smart| - |
Number of Undo Actons ]
Number of Most Recenty Used items

Logging 0}
pr——
[JRoute Messages to Fie G\sers luong\AppData\Roaming Orade mer i

Clear Log Fie on Next Launch
[ show Diagnostics Group on Smart View Ribbon

Display

e
[Coisplay Smart View Shortcut Menus Only.

Disable Smart View in Outock

Enabie Ribbon Context Changng

Disable optons that are not vaid for the actve connection
[ Sort Items in Smrt View Panel

[Coisplay rill-Through Report ToolTips

Show Progress Information After (seconds)
Compatbility

Reduce Excel Fie Size

0)

Improve Metadata Storage





image17.png
Q Tell me what you want to do

Pagelayout  Formulass  Data View

e @ B

Panel | Connections Refresh  Submit  Options
. B Functions~ | e | S

Start Edit Data General

Developer

P Help
 Shestnfo

&l More~





image18.png
Smart View e

‘Smart View Home @ >

+ Shared Connections
Connections fiom shared repository

& Private Connections
Local defined connections and shortauts o
shared connections

Recently Used




image19.png
Connect to Data Source [

User Authentiation Needed.
e

e
A —

Grea | [oemies

Server EssbaseCluster-1
URL https:/fuplan.ucsf.c/aps/SmartVien
Provider nalyticProvider Services





image20.png
Smart View \oes

‘Shared Connections @ - >»
Select Server to proceed <] -
Orade Essbase PROD

Oradie Hyperion Planring, Fusion Editon - Prod
Reporting and Analysis Framenork -Prod





image21.png
Smart View e
‘Shared Connections @ - >»

[owmmmmn T -

5@ EssbaseCiustert
59 ComiFvis

£ g ComiFY16

£ g ComiFY17

-9 CnmiFY18
e

g

_ g lomen Archives

g
g

@ Commtpn





image22.png
Options

HMember Options.

Data Optons:
Advanced

Formattng

celstyles

\;ﬂ Change member and dmension aptons o the gid.

[Preserve Formuias and Comments in ad hoc operations (except pivot and undo)

Formula Fil
Enable Enhanced Comment Handing
[Preserve Formula on POV Change





image23.png
Options

Data Options

Formattng

celstyles

Lﬁﬂ Change Smart Ve optons related to grid rows and columns.

Suppress Rows
[INo Data /Missing
Ozero

[ONo Access

Onvald

[underscore Characters
[Repeated Members.

iy T ——

[ONavigate without Data
Suppress Missing Blocks.





image24.png
Options

Data Optons:

Formatting

celstyles

™) Change grid formatting, stying and coloring options.

—
e —

@ Use Cell Styles.

(O Use Excel Formatting

[JRetain Numeric Formatting

] Adjust Column Width

e

Previen |

-

Previen |

Form 0

[Repeat Member Labels.





image25.png
Options

HMember Options.

Data Optons:
Advanced

Formattng

celstyles

\;ﬂ Change member and dmension aptons o the gid.

[JEnable Enhanced Comment Handing

Preserve Formuas and Comments in ad hoc operations (except pivot and undo)





image26.png
Options

Data Optons:

Formatting

celstyles

-5 Change grid fomattng, sylng and coloing options.

Formatting
Use Thousands Separator

O Use Cell Styles.

® Use Excel Formatting

Move Formatting on Operations

Retain Numeric Formatting

st ot idth
scle
review
Decil lces
review . 1
Form @

[Repeat Member Labels.





image27.png
Orade Essbase FROD <] -
[Orad Essbase #ROD. |

Oradie Hyperion Planring, Fusion Editon - Prod
Reporting and Analysis Framenork -Prod





image28.jpeg
= d = A
Scenario |Version |Fund |DeptiD _ Project





image29.png
Insert  Pagelayout  Formulas  Data

—5 19 Undo | 3 Copy 8
- o | @
Panel  Connections - Refresh | Submit
- | [
st ar -

Options

View
P Help
 Shestnfo

&l More~

General

Developer




image30.png
Home.

ZoomIn -}

S Zoom Out

5 Pivot +

Insert
3 Keep Oniy

2 Remove Only

Pagelayout  Formulas

! Member Selection

5 Query -
45 Member Information

5 Change Aliss

Data

Review.

Preserve Format

44 Insert Attributes

View

¥ Smart Slice

G Cascade~

Developer

Smart View

[ZESB O Tell me what you want to do.
B Calculate

2

N Dillthrough

@ Linked Objects
@ Ad

Submit
t

Data~
Data




image31.png
Member Selection

change in Net Position

[rotal Net Position - Beginning of Period
[ otal Net Position - End of Period
Ostatstical

x
 Account~ R 24 a-v-TY-
Enter a member name and dik Frnd. » - ‘Account

[Oacownt |

= fAucsF Accounts:

B

[ [ el |





image32.png
Level

Base Menber: UCSF Accounts





image33.png
Member Selection

4 Account~

change in Net Position

[rotal Net Position - Beginning of Period
[ otal Net Position - End of Period
Dstatstical

OAccount Total

4151C: MC-purchased svcs revenue

4153C: Other cricalrevenue
4154C: Affliation/contract revenue
4200C: Saes & service revenue
4250C: Recharge & costed central act

4500C: Sponsored project rev exc SFGH
4140C: SFGH affiation agresment
4550C: Interest and investment income:
4600C: Assessments

4650C: Patent revenue

4700C: Medical Center revenues

Th state appropriation

TRIR

THMCPSA

Th MC Purchased Services

T M Strategic Support

e





image34.png
Home Inset  Pagelayout  Formulas  Data  Review  View  Developer  smartView [y

@ Zoomin - BKeepOnly i MemberSelection (5] Preserve Format. 9% Smart Slice @ B Zverconmen moiwonn  E3
@, Zoom Out (2 Remove Only 43 Query - 8 Change Aliss (& Cascade - oty ol 8 Calute @ Linked Objects =
F pivet - ] MemberInformation |24 Data Perspective 44 Inset Atributes - RVisusize~ 8 Adjust Dt -
Anatsis Dats

m - %

| A [ B [ ¢ [ b [ E [ F [ & | n [ « L M N 0
1 Years  Scenario Version Fund  DeptlD Project
2 Account
3 |Period




image35.png
Home.

@, Zoomin - (3 Keep Oniy
& Zoom Out (= Remove Oy

5 Pivot +

Insert

Formulas

Data

Page Layout Review  View

f Member Selection
4 Query -

47| Member Information

(=] Preserve Format 7 Smart Slice.
8 Change Aliss (& Cascade -
Data Perspective W Inset Atributes

Analysis
fe | Account

D 3 F G H

Developer

@

Refresh

Smart View

POV,

= View Comments N Dilthrough

8

B Calculote Linked Objects
@ P Submit
R Visuslize~ 6 Adjust Data -
Data
K L M N





image36.png
Home Insert

@, Zoomin - (3 Keep Oniy
& Zoom Out (= Remove Oy

5 Pivot +

POV Sheet1 1

Pagelajout  Formuias  Data  Review  View  Developer  SmartView [N
Member Selection 5] Preserve Format. 9% Smart Sice @ [B] Zverconmens somwonn g3
2 Query - 8 Change Aliss (& Cascade - oty ool Boiuse @ unkedObecs =
#2) Member Information (551 Data Perspective ¥ Insert Attributes |~ £ Visualize - 8 Adjust Data~
Anatsis Dats

[ Years [ ][ scenario

[[verson [~ ][Fund

[owio -] o[-





image37.png
Home.

Zoomin

@, Zoom Out

5 Pivot +

Insert
3 Keep Oniy

2 Remove Only

Pagelayout  Formulas

! Member Selection

D Guery -
45 Member Information

5 Change Aliss

Data

Review.

Preserve Format

44 Insert Attributes

View

¥ Smart Slice

G Cascade~

Developer

Smart View

[ZESB O Tell me what you want to do.
B Calculate

2

N Dillthrough

@ Linked Objects
@ Ad

Submit
t

Data~
Data




image38.png
Member Selection %

4 Account~ PRI

[OTotal Net Position - Beginning of Period
[ otal Net Position - End of Period
Ostatstical

OAccount Total

B [ [ el |





image39.png
Options x
Menber Options: Eeill Change Smart View optons elted togrid rows and columms.
Data Options
Advanced o Data / Missing
Formattng zer0
- No Access
Ses Invaid
Extensons.

Underscore Characters
[Repeated Members.
Suppress Columns

NoData / Missing

zero ()

No Access (1)
Replacement
#NoData/Missing Label:
‘#NoAccess Label:
#Invalid/Meaningless:
Osubmit zero

I

Display Invaid Dats
Enable Essbase Format String

Mode
colDiloy e T
Dltavgate vithotDota

Suppress Missing Blocks





image40.jpeg




image41.jpeg
[Accor

unt

1234567
0




image42.jpeg
period
2 |account [ 1234567]

i




image43.jpeg
1 period
2 |Account | 1234567

3 Fund 0
=




image44.jpeg
A B <
1 period Year

2 [Account | 1234567

s 0





image45.jpeg




image46.jpeg
Account

Total Revenue

Total Expense

period
Years




image47.jpeg
A ]
Begal
period

Total Revenue

Total Expense.

5 | Account




image48.jpeg
1 Period Scenario
2 Years

3| TotRey 0
4| Totp 0
5 |Begeal o
e




image49.jpeg
g | Bw N =




image50.jpeg
V(O N

s = -
period Scenario
TotRev TotExp
Years Years
D100000
0999999




image51.jpeg
m N g e w N e

Period |scenario Version Fund
TotRev Totxp  BegBal
Years vears |Years

D100000

999999

Project




image52.png
Options

f Smart View options re
Data Options
Advanced No Data / Missing

zero
Formatting




image53.png
Options

Member Options.

Data Options





image54.png
Smart View X

=3 The worksheet contains data from prior operation. What do you want
10 do with the contents of the sheet?

? Clear sheet contents and POV

2 Reuse sheet contents only
Free form operation wil take place, existing POV wil b lost.

9 Reuse sheet contents and POV

New ad hoc conection/Smart Sice must be consistent with existing
contents.





image55.png
JEIERC I

A B

c| b | E F G

411100
YearTotal

TotRev 2,092,187

Tottxp | 4,275,903

TotothChg 3,696,282

FY20 Actual Final Total Funds Total Projects




image56.png
c

D E F G

1
2

3| Da11103  TotRev
4| pa11103  Totexp
5| DA411103 TotOthchg
6| D411106  TotRev
7| pa1106  Totexp
8 | D411106 TotOthChg
9 [Da11100  TotRev

10|Da11200  Totexp
110411100 TotothChg

20
YearTotal

1,721,420
3,906,003
3,697,148
370,767
369,900

(s67)
2,092,187
275,903
3,656,282

Actual Final Total Funds Total Projects




image57.png
> @ N o ;W N

A [} c

D E F G

Fr20

YearTotal
D411103  TotRev 1,721,420
D411103 Totexp | 3,906,003
D411103 TotOthChg | 3,697,148
Da11106  TotRev 370,767
Da11106  Totexp 369,900
D411106 TotOthChg (867)

Actual Final Total Funds Total Projects




image58.png
® N e U s W

A B c D E|F G
Fr20 Actual Final Total Projects
YearTotal

Total Funds D411103 TotRev 1,721,420

Total Funds D411103  Totexp 3,906,003

Total Funds D411103 TotOthChg 3,697,148

Total Funds D411106  TotRev 370,767

Total Funds D411106  Totexp 369,900

Total Funds.

D411106 TotOthChg

(867)




image59.png
@ N e n s W

D

E | F G

D411103 Total Funds  TotRev
D411103 Total Funds  TotExp
D411103 Total Funds TotOthChg
D411106 Total Funds  TotRev
D411106 Total Funds  TotExp
D411106 Total Funds TotOthChg

20
YearTotal

1,721,420
3,906,003
3,697,148
370,767
369,900

(867)

Actual Final Total Projects




image60.png
A ] c 2] E_F G
Fr20 Actual Final Total Projects
YearTotal

Da11103 5018 TotRev (11,713)

Da11103 "s018  Totexp 312,701

D411103 75018 TotOthChg 294,218

Da11103 5000 TotRev 1,733,133

Da11103 5000 Totexp 3,593,302

D411103 5000 TotOthChg 3,402,901

Da11106 5000 TotRev 370,767

Da11106 5000 TotExp 369,900

D411106

75000 TotOthChg.

(867)




image61.png
@ N e n s W

A B c 2} E F G
Fr20 Actual Final
YearTotal
D411103 5018 Total Projects | TotRev (11,713)
D411103 5018 Total Projects  TotExp 312,701
D411103 75018  Total Projects | TotOthChg. 294,218
D411103 5000 Total Projects | TotRev 1,733,133
D411103 5000 Total Projects  TotExp 3,593,302
D411103 5000 Total Projects | TotOthChg. 3,402,901
9 |pa11106 5000 Total Projects | TotRev 370,767
10 |D411106 5000 Total Projects  TotExp 369,900
11| D411106 "5000 Total Projects TotOthChg (867)




image62.png
A B c 2} E F G
Fr20 Actual Final
YearTotal

Da11103 5018 3800198 TotRev 214,130
Da11103 5018 3800198 TotExp 214,130
Da11103 5018 "8800132  TotRev (294,248)
Da11103 5018 8800132 TotOthChg 294,248
Da11103 5018 1111111 TotRev 68,405
Da11103 5018 1111111 Totexp 98,571
Da11103 5000 2014758 TotExp 422,164
D411103 5000 "2014758  TotOthChg 22,164
Da11103 5000 2014888 TotRev 750,000
Da11103 5000 2014888 Totexp 273,262
D411103 5000 "2014888  TotOthChg (475,738)
Da11103 5000 1111111 | TotRev 922,782
Da11103 5000 1111111 Totexp 2,331,830
D411103 75000 "1111111  TotOthChg 3,033,334
Da11103 5000 2000321 TotRev 60,351
Da11103 5000 2000321 Totexp 100,716
D4a11103 5000 2000321 TotOthChg 61,255
Da11103 5000 2015938  Totexp 72,200
Da11103 5000 2015938 TotOthChg (2,179)
Da11103 5000 2015913 Totexp 18,000
D411103 5000 2015813 TotOthChg (10,125)
Da11103 5000 2016271 TotOthchg -
Da11103 5000 2016815  TotExp 374,130
D411103 5000 2016815 TotOthChg 374,130
Da11106 5000 1111111 | TotRev 370,767
Da11106 5000 1111111 TotExp 369,900
D411106 5000 1111111 TotOthChg (867)




image63.png
Oracle Smart View for Office:

Essbase Error (1020051): Maximum number of rows processed [1000000]
exceeded [1000001]-





image64.png
A B c o E F |G
Fr20 Actual Final
YearTotal
D411103 5018 COSTED_CEN_ACTV  TotRev (80,118)
D411103 5018 COSTED_CEN_ACTV  TotExp 214,130
0211103 "5018  General TotRev. 68,405
Da11103 5018 General TotExp 98,571
Da11103 5018  Total Projects. TotRev (11,713)
Da11103 5018  Total Projects. TotExp 312,701
Da11103 5000 General TotExp 3,028,256
Da11103 5000 General TotOthChg 2,979,820
D411103 5000  PROG_INVESTMT  TotExp 565,046
D411103 5000  PROG_INVESTMT  TotOthChg 423,081
D4a11103 5000 Total Projects. Totexp 3,593,302
D4a11103 5000 Total Projects. TotOthChg 3,402,901
Da11106 5000 General TotRev. 370,767
D411106 5000  General TotExp 369,900
D411106 5000  General TotOthChg. (867)
D411106 5000 Total Projects. TotRev 370,767
D411106 5000 Total Projects. TotExp 369,900
D411106 5000 Total Projects. TotOthChg. (867)




image65.png
A B c D E F G

Fr20 Actual Final
YearTotal
D411103 5018 COSTED_CEN_ACTV  TotRev (80,118)
D411103 5018 COSTED_CEN_ACTV  TotExp 214,130
pa11103 “s018 | 1111111 TotRev 68,405
Dar1103 5018 | 1111111 Totexp 98,571
Da11103 5018 General TotRev. 68,405
D411103 5018 General TotExp 98,571
Da11103 5000 | 2014758 Totexp 422,164
Da11103 5000 | 2014758 TotOthChg. 22,164
Da11103 5000 ” 2014888 Totexp 273,262
Da11103 5000 | 2014888 TotOthChg. (475,738)
Dar1103 5000 | 1111111 Totexp 2,331,830
pa11103 5000 | 1111111 TotOthChg 3,033,334
D411103 5000 General Totexp 3,028,256
D411103 5000 General TotOthChg 2,979,820
D411103 5000 PROG_INVESTMT  TotExp 565,046
D411103 5000 PROG_INVESTMT  TotOthChg 423,081
Da11106 5000 | 1111111 TotRev 370,767
Da11106 5000 | 1111111 Totexp 369,900
Da11106 5000 | 1111111 TotOthChg. (867)
Da11106 5000 General TotRev. 370,767
D411106 5000 General TotExp 369,900
D411106 5000 General TotOthChg. (867)




image66.png
A B c 2} E F G
Fr20 Actual Final
YearTotal

D411103 5018 COSTED_CEN_ACTV  TotRev (80,118)
D411103 5018 COSTED_CEN_ACTV  TotExp 214,130
pa11103 “s018 | 1111111 TotRev 68,405
Dar1103 5018 | 1111111 Totexp 98,571
Da11103 5000 | 2014758 Totexp 422,164
Da11103 5000 | 2014758 TotOthChg. 22,164
Da11103 5000 ” 2014888 Totexp 273,262
Da11103 5000 | 2014888 TotOthChg. (475,738)
Dar1103 5000 | 1111111 Totexp 2,331,830
Dpa11103 5000 | 1111111 TotOthChg 3,033,334
Da11103 5000 ” 2000321 Totexp 100,716
Da11103 5000 | 2000321 TotOthChg. 61,255
Da11103 5000 ” 2015938 Totexp 72,200
Da11103 5000 | 2015938 TotOthChg. (2,179)
Da11103 5000 © 2015913 Totexp 18,000
Da11103 5000 | 2015913 TotOthChg. (10,125)
Da11103 5000 | 2016271 TotOthChg. -
Da11103 5000 ” 2016815 Totexp 374,130
Da11103 5000 | 2016815 TotOthChg. 374,130
Da11106 5000 | 1111111 TotRev 370,767
Da11106 5000 | 1111111 Totexp 369,900
Da11106 5000 | 1111111 TotOthChg. (867)




image67.png
A B

c | D E F G

201920
YearTotal

Total Revenue 479,541,852

Total Expense 454,820,455

Total Other Changes  (19,560,529)

Actual Final 400000: F_Finance & Administration Total Funds Total Projects




image68.png
c | D E F G

4000C: General state appropriations_C
4000E: General state appropriations.
4000C: General state appropriations
40008: General state appropriations
4100C: ICR & CCF appropriations_C
4100E: ICR & CCF appropriations.
4100C: ICR & CCF approoriations

2019-20
YearTotal

30,102,500
30,102,500
30,102,500

158,377,408
158.377.408

Actual Final 400000: F_Finance & Administration Total Funds Total Projects




image69.png
A B c D E F G
201920 Actual Final 400000: F_Finance & Administration Total Funds Total Projects
YearTotal
4000E: General state appropriations 30,102,500
4000C: General state appropriations 30,102,500
40008: General state appropriations 30,102,500
4100E: ICR & CCF appropriations 158,377,408
4100C: ICR & CCF appropriations. 158,377,408




image70.png
A ]

201920
YearTotal

4000E: General state appropriations 30,102,500
4100E: ICR & CCF appropriations 158,377,408
4201€: Sales & service - consulting -
4203€: Sales & service - educ- other 581,014
4204€: Sales & service - auxiliary 69,068,077
4250E: Recharges 194,333,604
4251€: Costed central activities 9,199,161
4601E: Other revenues 15,816,102
4304€: Student tuition & fees (other) 285,480
4305E: Transfer tuition and fees 299,659
4350E: Endowment income. 119,076
4351E: Gift revenue 1,818
4500: Grants and contracts - federal 125,000
4502E: Grants and contracts - private 10,000
4503€: Grants and contracts - local 122,915
4551E: STIP investment income 957,435
4600E: Assessments revenue 32,604

Total Revenue 479,541,852
S000E: Faculty salaries 78,630
S005E: Faculty vacation leave assess (214,917)
'5030: Faculty - UCRP benefits 8,539
S031: Faculty - retiree health bene 1333
'5032€: Faculty - medical/dental/vision 5,468
5033€: Faculty - other benefits 10,395
'5020E: Non-faculty academic salaries 4,578
'5043E: NF acad other benefits -
S050E: Staff salaries 157,166,947
S055E: Staff overtime 3,366,501
SO51E: Staff vacation leave assess 1,435,986
‘S060E: Staff - UCRP benefits 20,983,970
SO61E: Staff - retiree health 3,343,515
5062€: Staff - medical/dental/vision 18,351,154
S063E: Staff - other benefits 22,190,610
5204 Tfr-subaward expense 103,088
'5202E: Sponsored proj - F&A recovery 16,427
5503€: Depreciation - other ()
5201€: Sponsored proj - capital equip -
'5300E: Rentalylease - space/facility 2,135,960
5301E: General facilities service (807,652)
5302€: General facilities G&A (1,560)

'5303E: Custodial services 5,126,901




image71.png
A B c | Db £ F 6
201920 Actual Final 400000: F_Finance & Administration_{otal Funds Total Projects
YearTotal

4000E: General state appropriations 30,102,500

4100E: ICR & CCF appropriations 158,377,408

4201€: Sales & service - consulting
4203E: Sales & service - educ- other

581,014




image72.png




image73.png
A B c | D E F G

X ctual Final 400000: F_Finance & Administration Total Funds Total Projects
4000E: General state appropriations 30,102,500
Select Cascade Members
4100E: ICR & CCF appropriations 158,377,408
4201E: Sales & service - consulting. - Members.
42036 Sales & service - educ - other s81,014 Years
4204E: Sales & service - auxiliary 69,068,077 e=m
500 nesares B v
4251E: Costed central activities 5,199,161
4601E: Other revenues 15,616,102 =
4304E: Student tuition & fees (other) 285,480 DeptlD
430SE: Transfer tuition and fees 399,659 project
4350: Endowment income 119,076
4351E: Gift revenue 1,818
4500E: Grants and contracts - federal 125,000
4502E: Grants and contracts - private. 10,000
4503E: Grants and contracts - local 122,915 Number of cascaded sheets: 64 lII Cancel

4551E: STIP investment income. 957,435




image74.png
Number of cascaded sheets: 64





image75.png
Member Selection

4 DeptiD~

A-v-T-~

| rr—r——

Opeptin

= [Total Deptid

=[(]99999: Chancellor UCSF

{100000: M_School of Medicine.
{[1200000: Medical Center Main
[1200004: Health Jt Ventures Affiiates
[01300000: D_School of Dentistry
[0J315000: N_School of Nursing

[[J488015: ©_VC DiversitysOutreach
[489037: A_Office of Legal Affairs
1500000 W_Campuswide Financial Mgmt
{[510200: G_Foundation

[0515300: V_Development

535000 R_Commurications

536000 U_Community & Gov't Relations
{J634000: L_Langley Porter Hospital
Jowp_peptin

unspecified DeptiD





image76.png
Member Selection

4 DeptiD~

| rr—r——

Opeptin

= [Total Deptid

=[(]99999: Chancellor UCSF

{100000: M_School of Medicine.
{[1200000: Medical Center Main
[1200004: Health Jt Ventures Affiiates
[01300000: D_School of Dentistry
{315000: N_School of Nursing
{1330000: P_School of Pharmacy
{[]400000: F_Finance & Administration
[ 465000: E_Executive Vice Chancellor
{_Global Health Scences.
[ 485000: C_Office of the Chancellor
[[J488015: ©_VC DiversitysOutreach
[489037: A_Office of Legal Affairs

536000 U_Community & Gov't Relations
{J634000: L_Langley Porter Hospital
Jowp_peptin

unspecified DeptiD

20000.1: F_FAS Control Point Ops.
400002: F_FAS Control Point Pass Thru
201000: F_Real Estate

201002: F_SVC Imm Offce:

401011: F_Adnin Mgnt Professionals:
405000: F_Ctr for Commurity Engagement
406026: F_PMO UCSF Prog Mgt Offce:
207029: F_Audit & Advisory Services
408033: F_Fin VC-CFO

209049: F_Polce

410063: F_HR Human Resources.
411101: F_IT Info Tech Sves.

412130: F_OLS AVC





image77.png




image78.png
A B [ E F G

201820 Actual Finef 400001:F_FAS Control Point Ops [otal Funds Total Projects

YearTotal

4000E: General state appropriations
ICR & CCF appropriations 1,706,546
sales & service - consulting

: Sales & service - educ- other

les & service - auxiliary

echarges

: Costed central activities

Other revenues

tudent tuition & fees (other)

 Transfer tuition and fees

ndowment income
ift revenue
 Grants and contracts - federal
rants and contracts - private
rants and contracts - local
+ STIP investment income 11,830
Assessments revenue
1,718,376
: Faculty salaries
aculty vacation leave assess
aculty - UCRP benefits
: Faculty - retiree health bene
aculty - medical/dental/vision
aculty - other benefits
: Non-faculty academic salaries
F acad other benefits

taff - UCRP benefits
: Staff - retiree health

taff - medical/dental/vision
taff - other benefits

: Tr-subaward expense
ponsored proj - F&A recovery
Depreciation - other

: Sponsored proj - capital equip

2019-20-Actual-Final-Total F~2 | 2019-20-Actual-Final-Total F~3 |  2019-20-Actt





image79.png
Excel Options
General
View and manage Microsoft Office Add-ins.

Formulas

Proofing Addins

save Nome = Trocstor

Longuage [Actobat PDFMaker Offce COM Addin C\.e\OfficeEAPDFMOfficeAddin.di
[Analysis ToolPak

Advanced Analysis ToolPak - VBA

Customize Ribbon Date (ML) rosoft shared\Smart Tag\MOFLDLL

i Euro Currency Tools CA-\Office16\Libran\ EUROTOOLXLAM

Quick Access Toalbar || |yperon (Hyperion® Smart View recognizer)  C\Windows\System32\mscoree.il

_ Inquire C:\...Office\Office16\DCF\NativeShim.dIl
Microsoft Actions Pane 3

Trust Center Microsoft Power Map for xcel (Ccel Add-in\EXCELPLUGINSHELLDLL
Microsoft Power Pivot for xcel Cd-in\PowerPivotBxcelClientAddin.di
MicrosoftPower View for xcel C\d-inAdHocReportingbcelClentdl
Solver Add-in C\ce1\ibran\SOLVERVSOLVER XLAM

Document Related Add-ins
No Document Related Add-ins

Disabled Application Add-ins
No Disabled Application Add-ins

Oracle Smart View for Office

oK

Cancel





image80.png
Disabled Items [
The items lsted below are disabled because they prevented
Excel from functioning corredtly, o your system administrator
has disabled them through Group Polic.

Please note that you may have to restart Excelfor these.
changesto take place.

Select the ones you wish to re-enable.

There are no disabled ftems.





image81.jpg
L@: Budget and
Resource Management




